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Xftp Introduction 
Xftp is a powerful SFTP, FTP file transfer program for MS Windows platforms. SFTP (Secure Shell 
File Transfer Protocol) provides data encryption and user authentication for safer connection. It 
replaces the legacy FTP protocol. 
Xftp has been designed to satisfy both beginners and advanced users. It adopts the standard 
Windows style guide for easy and convenient user interface, and it works seamlessly with other 
Windows applications. It also provides advanced users with powerful features. For a full list of 
features in Xftp, see “Features”. 

Features 
This section describes key features in Xftp. 

General 
• Supports SFTP (SSH2 only) and FTP protocols 
• Runs on Windows 2000 and above 
• Supports virtualized evironment 
• Supports OpenSSH, ssh.com  and other SSH servers that follows SFTP protocol standards 
• Configures for Multi-users  
• Contains Keep-alive option 
• Supports UTF8 string 
• Supports various Proxy servers 
• Supports FXP for server to server direct transfer 

Session management 

• Import and export session files 
• Session files can be created and managed for different hosts 
• Three convenient methods to open a session; using the Sessions dialog box, Quick 

Connect bar, and Shortcut 
• Default session provides a quick connection establishment 
• Quick Connect bar supports URL commands to connect to a remote host 
• Supports folder and tree views in the Sessions dialog box 
• Option to reopen last used local and remote tabs 

Security 

• RSA/DSA Public Key, Password, and Keyboard Interactive authentication methods 
• RSA/DSA key generation wizard and import/export features 
• AES128/192/256, 3DES, BLOWFISH, CAST128, ARCFOUR, and RIJNDAEL encryption 

methods 
• SHA1, SHA1-96, MD5, MD5-96, and RIPEMD160 MAC algorithms 
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• zlib compression 
• Host key management dialog box 
• User key management dialog box 

Appearance 

• Simple and powerful user interface 
• Multiple pane support for easy file transfers 
• Adjustable toolbar 
• Customizable buttons on the Standard buttons toolbar 

File transfer 

• Upload and download via drag & drop 
• Transfers multiple files simultaneously 
• Supports pause/resume of transfer 
• Supports restart for the failed transfers 
• Displays transfer queue in folder tree view 
• Displays the transfer status in graphical mode 
• Supports synchronization between local and remote folder 

File management 

• Supports direct editing of the remote files 
• Supports multiple local folder views 
• Supports to delete and rename files 
• Supports to create a new folder 
• Supports to execute a file 
• Supports to change permissions of a remote file 

Interoperability 

• Interoperable with Windows explorer 
• Interoperable with Xshell® 
• Interoperable with Xagent  
• Interoperable with Xbrowser 

System requirements 
• Operating System: Microsoft Windows® 2000 SP4 or above 
• Hard disk: Over 50M bytes free space 
• Network: TCP/IP Winsock 1.1 compatible 
• Required software: Internet Explorer® 6.0 or later 

Installation and uninstallation 
Xftp installation program is available for download at http://www.netsarang.com/. It is packaged 
with the widely used InstallShield® installation program, and to begin the installation process, 

http://www.netsarang.com/�
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simply run the executable file after downloading it. 
The Xftp installation process includes several steps with options for you to modify the default 
installation. However, in most cases, just clicking Next button will be enough for the installation. 

To uninstall the Xftp program, follow the standard Add/Remove feature of Windows. In the Control 
Panel, double-click Add/Remove Programs, click Xftp in the program list, and then click the 
Change/Remove button. 

IMPORTANT: The uninstallation process will not remove the registry information and data files 
generated by users. It can be used again when you need to re-install Xftp later. If you want to 
remove all the files and registry information completely, you need to remove the following 
explicitly: 

Registry key: 
• \HKEY_CURRENT_USER\Software\NetSarang\Xftp 

• \HKEY_CURRENT_USER\Software\NetSarang\Xmanager Enterprise 

Files and folders: 
• %APPDATA%\NetSarang\Xftp 

• %APPDATA%\NetSarang\Xmanager Enterprise 

Technical support 
The overall guide and references are explained in detail in this Help manual. If you cannot find the 
solution to your problem in the manual, please visit our web site at: 
http://www.netsarang.com/support/main.html 
You can either post your questions on Xftp Q&A Forum or use our request support form in our 
online customer support page. Support request form is available at: 

http://www.netsarang.com/support/request_form.html 

We will be able to support you better if you describe your problem as detailed as possible. 

Xftp License Agreements 
This license agreement applies to the registered version of Xftp. 

License Agreement 

Carefully read the following terms and conditions before using this software. Your use of this 
software indicates your acceptance of this license agreement.  

Software Distribution 

No component part of any version of Xftp may be distributed individually, disassembled, copied, 
reverse engineered, or altered in any form. 

Registered Version 
One registered copy of Xftp may either be used by a single person who uses the software 
personally on one or more computers, or installed on a single workstation used non-simultaneously 
by multiple people, but not both. 

You may access the registered version of Xftp through a network, provided that you have obtained 

http://www.netsarang.com/support/main.html�
http://www.netsarang.com/support/request_form.html�
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individual licenses for the software covering all workstations that will access the software through 
the network. For instance, if five different workstations access Xftp on the network, each 
workstation must have its own Xftp license, regardless of whether they use Xftp at different times 
or concurrently. 

Title and Copyright 
The software (including any images, applets, photographs, animations, video, audio, music and 
text incorporated into the software) is owned by NetSarang Computer, Inc., or its suppliers and is 
protected by Korean copyright laws and international treaty provisions. Part of this software may 
have been developed by a third party software supplier, which holds copyright and other 
proprietary rights to the software. 

This software is licensed to you. You are not obtaining title to the software or any copyrights. You 
may not sublicense, rent, or lease the software for any purpose. The license may be transferred 
(not resold) to another individual only if you keep no copies of the software. 

Disclaimer of Warranty 
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES 
AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED 
OR IMPLIED. Because of the various hardware and software environments into which Xftp may be 
put, NO WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED. 

Xftp is a trademark of NetSarang Computer, Inc. 
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Getting Started 
This section describes how to create an FTP or SFTP session and how to connect to remote 
Linux/Unix hosts. While an FTP session is very simple to be established, an SFTP session might 
require a user key that should be registered to the SFTP server before any connection is made. If 
you need the user key registration for SFTP sessions, see “Public Key User Authentication.” 

Creating a session 
You can create an FTP or SFTP session. 

1. On the File menu, click New.  
RESULT: The New Session dialog box appears. 

 

Figure 1: New Session 
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2. In the Name box, enter a session name. 
3. In the Host box, enter the hostname or IP address of the server.  
4. In the Protocol list, select an appropriate protocol.  
5. In the Port Number box, type or select the port number used by the remote server.  
6. In the User Name box, enter an account name of the remote server. 

 Notes 

If the User Name box is left empty, a dialog box asking a user name will appear when you 
attempt to connect the session. 

7. Click OK. 
RESULT: A new session has been created and you are ready to connect to the remote host 
now. To connect to the remote host, see “Connecting to a remote host with SFTP” or 
“Connecting to a remote host with FTP”. 

Connecting to a remote host with SFTP 
Once you have created an SFTP session, you can now connect to the remote host. If there are no 
sessions created, see Creating a session first. 

1. On the File menu, click Open. 
2. In the session list, select the session you want to connect to and click Connect.  

RESULT: The SSH User Authentication dialog box appears. 

 Notes 

If the session has no User Name, a dialog box asking the user name will appear. 
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Figure 2: SSH User Authentication 

3. For the Password authentication, just enter your password in the Password box, and click OK. 
4. For the Public Key authentication, select a user key in the list and type a passphrase in the 

Passphrase box and click OK.  

 Notes 

If there is no user key, see “Public Key User Authentication”. 

5. For the Keyboard Interactive (Generic Message Exchange) authentication, just click OK and 
then generic authentication steps will follow. 

If you have any problems using Xftp, see, “Error Messages. 

Connecting to a remote host with FTP 
Once you have created an FTP session, you can now connect to the remote host. If no sessions are 
created, see Creating a session first. 

1. On the File menu, click Open. 
2. In the session list, select the session you want to connect to and click Connect.  

RESULT: The FTP User Authentication dialog box appears. 
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Figure 3: FTP User Authentication 

3. Enter a user name in the User Name box and enter your password in the Password box, 
and click OK. 

If you have any problems using Xftp, see, “Error Messages”. 

Transferring files 
Transferring files from a remote server 
If an SFTP or FTP connection is established, you can download files. 

1. In the Remote Folder window, select files to download. 
2. Drag the files and drop them on to a Local Folder. 
If you have any problems downloading files, see “Error Messages”. 

 Notes 

You can also transfer files by clicking the Left or Right arrow button on the Standard 
Buttons toolbar. 

Transferring files to a remote server 
If an SFTP or FTP connection is established, you can upload files. 

1. In the Local Folder window, select files to upload. 
2. Drag the files and drop them on to a Local Folder. 
If you have any problems uploading files, see “Error Messages”. 

 Notes 

You can also transfer files by clicking the Left or Right arrow button on the Standard 
Buttons toolbar. 

Transferring files between local folders 
1. In the Local Folder window, select files to transfer. 
2. Drag the files and drop them on to another Local Folder. 

Transferring files between remote servers 
If an SFTP or FTP connection is established, you can upload files. 
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1. In the Remote Folder window, select files to transfer. 
2. Drag the files and drop them on to a Remote Folder. 

Moving a tab to a different tab group 
You can move the Remote and Local tab to a different tab groups. To do this: 

1. Open two or more tab groups.   
2. Drag the tab and drop it on to either end of Xftp main window. 

RESULT: Outline of a grey box shows where the tab will be placed when you drop it.  

Exiting Xftp  
To exit Xftp, click Exit on the File menu. 
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Managing Sessions  
A session contains properties of a connection to a remote host. By creating a session, you can 
specify different options for each remote computer and connect to the remote computer easily with 
one click. The Sessions dialog box lists all the sessions you have created and allows you to create 
and edit sessions. 
You can also connect to a remote computer without creating a session. For this purpose, Xftp 
provides a default session that is ready to be used after installation. 

Managing sessions 
To create a new session: 
1. Open the New Session dialog box. 
2. Enter connection information. 
3. Click OK. 

 Notes 

The created session is entered to the Sessions dialog box. You can edit the session later. 

To edit a session: 
1. Open the Sessions dialog box. 
2. Select the session you want to edit. 
3. On the toolbar, click Properties. 
4. Edit the session and click OK. 

To change the name of a session: 
1. Open the Sessions dialog box. 
2. Right-click on the session with the name you want to change. 
3. Click Rename on the menu. 

 Notes 

The session name should be made up of valid characters to be used as a filename. 

To save an existing session as another name: 
1. Open the Sessions dialog box. 
2. Select the session you want to save as another name. 
3. On the toolbar, click Save As. 

To delete a session: 
1. Open the Sessions dialog box. 
2. Select the session you want to delete. 
3. On the toolbar, click Delete. 
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To create a shortcut for a session: 
1. Open the Sessions dialog box. 
2. Select the session for which you want to create a shortcut. 
3. On the toolbar, click Shortcut. 
4. Browse the folder tree and select a folder to put the shortcut. 
5. Click OK. 

To edit the properties of the default session: 
1. Close all the connections if Xftp is already connected to remote computers. 
2. On the File menu, click Properties.   

RESULT: The Properties dialog box appears. 

 Notes 

The default session is used when you enter an ftp or sftp connection command on the Quick 
Connect bar. 

To create a new session folder:  
1. Open the Sessions dialog box. 
2. Click on an arrow next to the New button, and then select Folder from the list. 
3. Type a name for the new folder, and then press ENTER. 

To copy a session file to a different computer: 
1. Open Sessions dialog box. 
2. Click on the Open Session Folder button.  

RESULT: Folder, where sessions are saved, opens up. 
3. Find a session file (*.xfp) and copy or email it to a different computer. 

4. Save the session file in the following folder.  
"%APPDATA%\NetSarang\Xftp\Sessions"  

Export sessions 
Xmanager supports exporting sessions. Sessions are exported to single file for easy import. You 
can import the exported session file from a different PC where Xmanager is installed and use it 
without extra configuration. To export sessions: 

1. Run Xbrowser. 
2. Click on the File menu, select the Export menu. 

RESULT: The Import/Export wizard dialog box opens. 
3. Select the products to export its sessions, and then click the Next button. 
4. Select the folder where the exported session file will be saved and then click the Next button. 

RESULT: Sessions are exported to a single file. 
5. Click the OK button to close the Import wizard. 
 



 

Managing Sessions   |   13 

Import sessions 
Xmanager supports importing sessions. You can import sessions from the lower Xmanager versions 
from the same PC or the exported session file that is exported from a different PC. To import 
sessions: 

1. Run Xbrowser. 
2. Click on the File menu, select the Import menu. 

RESULT: The Import/Export wizard dialog box opens. 
 
• To import sessions from the previously installed products on the same PC: 
3. Select the From the previously installed products on this computer option, and the click 

the Next button. 
RESULT: Products and its sessions are listed. 

4. Select the products to import sessions from and then click the Next button. 
RESULT: Sessions are imported and the result is displayed. 

5. Click the OK button to close the Export wizard. 
 
• To import sessions from an exported session file: 
3. Select the From the following location option. 
4. Enter the path of the exported session file or click the … button to select the exported session 

file.  
5. Click the Next button to continue. 

RESULT: Products and its sessions are listed. 
6. Select the name of the products to import sessions from, and then click the Next button. 

RESULT: Sessions are imported and the result is displayed. 
7. Click the OK button to close the Export wizard. 

 





 

Establishing Connections   |   15 

Establishing Connections 
Xftp provides many convenient connection methods: Sessions dialog box, Links bar, Quick 
Connect bar, and Shortcut. With the convenient Xftp user interface, you can connect to a remote 
computer with or without creating a new session. If you have already created a session for a 
remote computer, you can just open the session to connect to the remote computer.  
With Xftp, users can manage multiple local folders simultanesouly to increase productivity when 
working with multiple sessions. 
Xftp supports FTP and SFTP protocols, and the remote computer must support one of these 
protocols to make connection. 
For more information on sessions, see “Managing Sessions”. For more information on Quick 
Connect bar, see “Quick Connect bar”. 

Connecting without a session 
You can connect to a remote computer quickly by entering a command at the Quick Connect bar 
without creating a session.  

To connect to a remote computer at the Quick Connect bar: 
1. Enter one of the following commands into the Hostname field: 

• ftp://hostname 

• sftp://hostname 

• hostname  

 Notes 

If you do not specify the protocol, the default protcol configured under the default session 
profile is used.  

2. Enter the username and password in the username and password fields. (optional) 
3. Press the Enter key, or click the Connect button. 

 Notes 

You can also enter a user name and a port number at the commands. For more information on 
the command usage, see “Quick Connect bar”. 

Connecting with a session 
When you connect to a remote computer repeatedly, you may find it helpful to create a session for 
the connection. A session allows you to connect to the remote computer easily with a single click 
or a command. If a session is already created, you can open it at the Sessions dialog box to 
connect to the remote computer. 

To connect to a remote computer at the Sessions dialog box: 
1. Open the Sessions dialog box. 
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2. Select the session you want to open. 
3. Click Connect. 

To connect to a remote computer with a shortcut: 
1. Double-click the shortcut icon of a session. 

 Notes 

For more information on creating a shortcut of a session, see the “Managing Sessions” section. 

Disconnecting from a remote server 
You can disconnect without closing the Remote Folder window. If the Remote Folder window is 
open, you can reconnect the session whenever you choose. For the detaild information on 
reconnection, see “Reconnecting to a remote server”. 

To disconnect: 
1. On the Standard Buttons toolbar, select Disconnect. 

Reconnecting to a remote server 
The disconnected session can be reconnected anytime. When reconnecting to a remote server, the 
user authentication information from the last connection will be reused.  

To reconnect: 
1. On the Standard Buttons toolbar, select Reconnect. 

 Notes 

To make it possible to reconnect, the Remote Folder window should remain opened. 

Establishing multiple connections 
Xftp supports simultaneous connections to multiple hosts. Thus, you can transfer files from/to 
multiple hosts simultaneously. 

To connect to multiple hosts: 
1. If you make connections from Quick Connect bar or Sessions dialog box, Remote Folder 

windows will be created as many as the number of the connections. 

 Notes 

To move to each Remote Folder window, see “Managing Window”.  

Connecting in passive mode 
In the FTP connection, you can choose Passive mode. For more information on Passive mode, see 
“Data Connection Type” of “Command menu”. 
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To connect in Passive Mode from a session: 
1. Open the Sessions dialog box. 
2. Select the session you wish to connect. 
3. Click Properties on the Toolbar. 
4. Click Options tab on the Properties dialog box. 
5. Check Passive Mode. 
6. Click OK. 
7. Connect this session. 

 Notes 

If the Passive Mode is already selected, you can connect the session directly without changing 
the session properties. 

To connect in Passive Mode from Quick Connect bar: 
1. Close all Remote Folder tabs. 
2. Do one of the followings: 

• Click Properties on the File menu. 
• Click Properties on the Toolbar. 

3. On the Properties dialog box of the default session, click the Options tab. 
4. Check Passive Mode. 
5. Click OK. 
6. Connect from the Quick Connect bar. 

 Notes 

If the Passive Mode is already selected in the default session properties, you can connect 
directly from the Quick Connect bar without making any change. 

Connecting in active mode 
In the FTP connection, you can choose Active mode. For more information on Active mode, see 
Command menu. 

To connect in Active Mode from a session: 
1. Open the Sessions dialog box. 
2. Select a session to connect to. 
3. Click Properties on the Toolbar. 
4. Click Options tab on the Properties dialog box. 
5. Uncheck Passive Mode. 
6. Click OK. 
7. Connect this session. 

 Notes 

If the Passive Mode is already unchecked in the session properties, you can connect the 
session directly without making any change. 
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To connect in Active Mode from Quick Connect bar: 
1. Close all Remote Folder windows. 
2. Do one of the followings: 

• Click Properties on the File menu. 
• Click Properties on the Toolbar. 

3. On the Properties dialog box of the default session, click Options tab. 
4. Uncheck Passive Mode. 
5. Click OK. 
6. Connect from the Quick Connect bar. 

 Notes 

If the Passive Mode is already unchecked in the default session properties, you can connect 
directly from the Quick Connect bar without making any change. 

Setting the initial folder 
In Xftp, users can set different initial remote and local folder for each session. Also, with 
the multiple local folder view feature, users can have different local working directories open for 
each session. When an Xftp session starts, the initial folders are displayed on local and remote 
folder window. To access your frequently used folders faster, set it as your initial folder.  

To set the local initial folder: 
1. Open the Sessions dialog box. 
2. Select a session to set the local initial folder. 
3. Click Properties on the Toolbar. 
4. Click Options tab on the Properties dialog box. 
5. Do one of the followings: 

• Enter the initial folder on the Local Initial Folder box. 
• Click Browse and select the folder from the dialog box. 

6. Click OK. 

To set the remote initial folder: 
1. Open the Sessions dialog box. 
2. Select a session to set the local initial folder. 
3. Click Properties on the Toolbar. 
4. Click Options tab on the Properties dialog box. 
5. Enter the initial folder on the Remote Initial Folder box. 
6. Click OK. 
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Public Key User 
Authentication 
Xftp supports the public key user authentication method that is an alternative way of identifying a 
user to a remote server instead of typing a password.  
To use the public key user authentication method, a user generates a user key pair consisting of a 
public key (which everybody is allowed to know) and a private key (which is kept secret and not 
given to anyone). When the public key authentication is in progress, the private key is used by 
Xftp to generate a signature, and the public key is used by the SSH server to verify the signature. 
That is, the possession of the private key works as an identity of the user. Also, the user should 
register his public key to the server in order to be authenticated. For more information on the user 
keys, see “User Keys dialog box”. 
A user key can be created in the SSH server or Xftp. If it is created in the server, you should 
import the private key to the database of Xftp. If it is created in Xftp, you should register the 
public key to the server. 

To create a user key pair: 
1. On the Tools menu, click User Key Generation Wizard. 
2. The User Key Generation Wizard will guide you through the whole generation process. 

 Notes 

At the final step of the generation process, you can also register the public key on the remote 
SSH server. 

To register a public key on the server: 
1. Open the User Keys dialog box. 
2. Select the user key you want to register. 
3. Click Properties.   

RESULT: The User Key Properties dialog box appears. 
4. Click the Public key tab. 
5. In the list “View public key format as”, select an appropriate format depending on the type of 

your remote SSH server. 
6. Click Save As a File. 

 Notes 

After the public key is saved as a file, you should copy it to the remote server. How to register 
the copied key into your remote SSH account is different for each server and you may find it 
helpful to read “Step 4: Public Key Registration”. 

To import a private key to the database: 
1. Open the User Keys dialog box. 
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2. Click Import.  
RESULT: The Open dialog box appears. 

3. Select the private key file you want to import and click OK.  
4. Click OK. 

To export a user key to a file: 
1. Open the User Keys dialog box. 
2. Select the user key you want to export. 
3. Click Export.  

RESULT: The Save As dialog box appears. 
4. Enter a file name and click OK. 

 Notes 

The exported file is in the NetSarang User Key format and it cannot be used in the applications 
provided by other vendors. You may find it useful to export user keys when trying to use the 
same private key in Xftp installed in another computer. 

To change the name of a user key: 
1. Open the User Keys dialog box. 
2. Select a user key you want to change. 
3. Click Rename. 

 Notes 

Notice that the key name is used as a file name. You must enter only valid characters for the 
name. 

To change the passphrase of a user key: 
1. Open the User Keys dialog box. 
2. Select a user key. 
3. Click Properties.  

RESULT: The User Key Properties dialog box appears. 
4. Click the General tab. 
5. Click Change Passphrase. 

To delete a user key from the database: 
1. Open the User Keys dialog box. 
2. Select the user key you want to delete. 
3. Click Delete. 
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Transferring Files 
Xftp provides various file transfer methods: transfer left/transfer right menu, copy-and-paste, and 
drag-and-drop. It also provides options for duplicate files such as overwrite, resume, rename, and 
ignore. In addition, Xftp supports simultaneous file transfer to improve performance of multiple 
file transfers. Also, while transfering folders, its contents are displayed as tree structure in the 
transfer status window.  

Downloading files 
You can download files or folders from the remote computer in various ways. 

To download files with menu: 
1. Select files to download in the Remote Folder window. 
2. Place the Local Folder window on either side of the Remote Folder window by dragging its 

tab. 
3. Choose one of the following options: 

• On the Command menu, select Transfer Right or Transfer Left depending on where 
the local folder is located. 

• From the menu opened by the right-click in the Remote Folder window, click the Left or 
Right transfer button. 

To download files with drag and drop: 
1. Select files to download in the Remote Folder window.  
2. Drag the selected files and drop them onto the Local Folder. 

 Notes 

The selected files can be dropped onto the Desktop or Window Explorer. 

To download files with copy and paste: 
1. Select files to download in the Remote Folder window.  
2. Choose one of the following three options: 

• On the Edit menu, click Copy. 
• From the menu opened by the right-click in the Remote Folder window, click Copy. 

3. Click the Local Folder window. 
4. Choose one of the following three options: 

• On the Edit menu, click Paste. 
• From the menu opened by the right-click in the Local Folder window, click Paste. 

To download files after creating a download list: 
1. Select files to download in the Remote Folder window. 
2. Right-click on the selected files, and then click Queue. 
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To resume downloads from pause: 
Perform one of the following actions. 
1. In the Transfers window, right-click on the paused transfer, and then click Resume. 
2. Right-click on the Transfer window, click Resume All. 
 

Uploading files 
You can upload files or folders to the remote computer in various ways.  

To upload files with menu: 
1. Select files to upload in the Local Folder window. 
2. Place the Remote Folder window on either side of the Remote Folder window by dragging 

its tab. 
3. Choose one of the following options: 

• On the Command menu, select Transfer Right or Transfer Left depending on where 
the remote folder is located. 

• From the menu opened by the right-click in the Local Folder window, click the Left or 
Right transfer button. 

To upload files with drag and drop: 
1. Select files to upload in the Local Folder window. 
2. Drag the selected files and drop them onto the Remote Folder window. 

 Notes 

You can also drag files from the Windows Explorer and drop them onto the Remote Folder 
window. 

To upload files with copy and paste: 
1. Select files to upload in the Local Folder window. 
2. Choose one of the following three options: 

• On the Edit menu, click Copy. 
• From the menu opened by the right-click in the Local Folder window, click Copy. 
• On the Toolbar, click Copy. 

3. Click the Remote Folder window. 
4. Choose one of the following three  options: 

• On the Edit menu, click Paste. 
• From the menu opened by the right-click in the Remote Folder window, click Paste. 
• On the Toolbar, click Paste. 

 Notes 

You can also copy files from the Windows Explorer and paste them to the Remote Folder 
window. 

To upload files after creating an upload list: 



 

Transferring Files   |   23 

1. Select files to upload in the Local Folder window. 
2. Right-click on the selected files, and then click Queue. 

To resume uploads from pause: 
Select one of the following methods. 
1. In the Transfer window, right-click on the paused transfer, and then click Resume. 
2. Right-click on the Transfer window, and then click Resume All. 

 

Removing the file transfer 
You can stop and remove the file transfer. 

To stop and remove all transfers: 
Right-click on the Transfer window and click Remove All from the  

1. Transfer window menu. 

To stop and remove some transfers: 
1. Select files of which you want to stop the transfer. 
Right-click on the Transfer window, and click Remove from the  

2. Transfer window menu. 

To delete finished transfers’ logs: 
Right-click on the Transfer window, and click Delete Finished Transfers from the  

1. Transfer window menu. 

Synchronizing folders 
You can synchronize a local and a remote folder. Follow the instruction below: 
1. Open a local folder tab and a remote folder tab to synchronize. 
2. From the Standard Buttons toolbar, select the Synchronize icon. 

RESULT: Synchronization dialog box opens. 
3. Click OK to compare files. 

RESULT: Files that are going to be transferred shows up as selected. 
4. Click the Transfer Now button to begin transfer. 

Pausing the file transfer 
You can temporarily stop the file transfer. 

To stop all transfers: 
Right-click on the Transfer window and click Pause All from the  

1. Transfer window menu. 

To stop transfers for the selected files: 
1. In the Transfer widnow, select the files of which you want to stop transferring. 
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Right-click on any of the selected files, and click Pause from the  

2. Transfer window menu. 

Restarting the file transfer 
To resume all paused transfers: 
Right-click on the Transfer window and click Resume All from the  

1. Transfer window menu. 

To resume paused transfer for the selected files: 
1. In the Transfer window, select files of which you want to resume the transfer. 
Right-click on any of the selected files, and click Resume from the  

2. Transfer window menu. 

To restart all failed transfers: 
Right-click on the Transfer window and click Restart All Failed from the  

1. Transfer window menu. 

Viewing the transfer status 
Xftp allows you to check the status of each file transfer. It is useful when you want to find failed 
transfers. 

To check the transfer status: 
1. In the Transfer window, select a file that you want to check the transfer status. 
2. Right-click on the selected file, and click Show Transfer Status. 

 Notes 

For more information on the transfer status, see “Transfer Status dialog box”. 

Transferring text files 
The new line character can vary depending on the system type. When you use ASCII transfer, Xftp 
will automatically convert the new line characters to match the system type. This allows users to 
view text files from a different system without extra converting procedure. 

To transfer text files: 
1. On the Command menu, point to Transfer Type and click ASCII 
2. Transfer files. 

 Notes 

Xftp can select Transfer Type for each file type. For more information on transfer type, see 
“Session Folder 

Select a folder to save Xftp sessions.  
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Temporary Folder 

Select a temporary cache folder you want to save temporary files. Xftp deletes files in this folder 
when exits.  

ASCII Extensions dialog box” 

Transferring binary files 
Xftp allows you to transfer binary files. All files except for text files should be transferred in binary 
mode. 

To transfer binary files: 
1. On the Command menu, point to Transfer Type, and click Binary. 
2. Transfer files. 

 Notes 

Xftp can select Transfer Type for each file type. For more information on transfer type, see 
“Session Folder 

Select a folder to save Xftp sessions.  

Temporary Folder 

Select a temporary cache folder you want to save temporary files. Xftp deletes files in this folder 
when exits.  

ASCII Extensions dialog box”. 

Resuming file download 
You can resume any stopped downloading. If a file to be transferred already exists in the local 
directory and it is smaller than the one that is about to be downloaded, you can resume the 
downloading. When resume downloading a folder, Xftp checks the size of each file within the folder 
and selectively downloads the required files. 

To append to the local exiting file: 
1. Select the file in the Remote Folder window, and click Download. 
2. In the File Exists dialog box, select Resume. 

Resuming file upload 
You can resume any stopped uploading. If a file to be transferred already exists in the remote 
directory and it is smaller than the one that is about to be uploaded, you can resume the uploading. 
When resume uploading a folder, Xftp checks the size of each file within the folder and selectively 
uploads the required files. 

To append to the remote exiting file: 
1. Select the file in the Local Folder window, and click Upload. 
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2. In the File Exists dialog box, select Resume. 

Renaming files after the transfer is completed 
Xftp can perform various actions when transfers are completed. You can change the file name with 
uppercase or lowercase letters. 

 Notes 

This is a global option, so it is applied to all sessions. 

To change all file names to lowercase: 
1. Open the Options dialog box. 
2. Click Transfer tab. 
3. Click Advanced Options. 

RESULT: The Transfer Options dialog box appears. 
4. In the File Name area, select Lowercase for Download/Upload options. 

 Notes 

You can set this option for both download and upload. 

To change all file names to uppercase: 
1. Open the Options dialog box. 
2. Click Transfer tab. 
3. Click Advanced Options. 

RESULT: The Transfer Options dialog box appears 
4. In the File Name area, select Uppercase for Download/Upload options. 

 Notes 

You can set this option for both download and upload. 

To change the first letter of file names to uppercase:  
1. Open the Options dialog box. 
2. Click Transfer tab. 
3. Click Advanced Options. 

RESULT: The Transfer Options dialog box appears 
4. In the File Name area, select Capitalize for Download/Upload options. 

 Notes 

You can set this option for both download and upload. 
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Managing Files 
Xftp provides easy and convenient user interface for managing local and remote file system. You 
can execute, rename, and delete a file, or create a new folder. Users can directly edit files in the 
remote system by using the text editor installed on users’ PCs. And, since Xftp has an user 
interface similar to Windows Explorer, users can more easily and conveniently manage the remote 
files. 

Executing a file 
You can execute the associated program for files in a local or remote computer. If you execute a 
local folder, an Explorer window opens. 

To execute or open a file: 
1. Right-click a file from the Local or Remote Folder window.  

RESULT: A menu appears. 
2. Click Open. 

 Notes 

If you open a remote file, it is downloaded to a local temporary folder first, and then it is 
executed with an associated program in Windows. You cannot excute a remote folder. 

Changing the name of a file or folder 
You can change the name of a file or folder. 

To change the name of a file or folder: 
1. In the Local or Remote Folder window, select a file or folder that you want to change the 

name. 
2. Choose one of the following options: 

• On the Command menu, click Rename. 
• Right-click on the Local or Remote Folder window, and click Rename. 

3. When an input box appears, enter a new file name. 
4. Click Enter. 

Deleting files or folders 
You can delete files or folders. When you delete a folder, it will delete all files within the folder. You 
can cancel deleting at any time. 

To delete a file or folder: 
1. In the Local or Remote Folder window, select a file or folder you want to delete. 
2. Choose one of the following options: 

• On the Command menu, click Delete. 
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• Right-click on the Local or Remote Folder window, and click Delete. 
3. In the confirmation dialog box, click Yes. 

To stop deleting of remote file: 
1. In the deleting dialog box, click Cancel. 

Editing text files with Notepad 
You can edit the remote text files directly. 

To edit a remote text file: 
1. In the Remote Folder window, select a file you want to edit. 
2. Choose one of the following options: 

• Right-click on the selected files, and then click Edit with Notepad. 
• Right-click on the selected files, click Edit with user defined editor. 

 Notes 

User definined editor is the editor users choose in the Advanced Tab of the Options dialog box. 

Creating a new folder 
You can create a new folder in the remote or local folder. 

To create a new folder: 
1. Click the Local or Remote Folder window. 
2. Choose one of the following options: 

• On the Command menu, click New Folder. 
• Right-click on the Local or Remote Folder window, and click New Folder. 

3. When an input box appears, enter the folder name. 
4. Click Enter. 

Changing the permissions of UNIX files 
You can change the permissions of a file in the remote computer. This only applies to Unix/Linux 
system. 

To change the permissions of a file located on the remote computer: 
1. In the Remote Folder window, select a file to change the permissions of. 
2. Choose one of the following options: 

• On the Command menu, click Change Permissions. 
• Right-click on the Remote Folder window, and click Change Permissions. 

3. In the Change Permissions dialog box, select the permissions. 
4. Click OK. 

 Notes 

In some remote computers, changing file permissions may not work. 
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Viewing the file properties 
You can view detailed file properties such as size, location and permission. 

To see the file properties: 
1. In the Local or Remote Folder window, select the file whose properties you want to view. 
2. Right-click on the Folder window, and click Properties. 
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Logging Session 
Xftp logging feature allows users to keep the record of upload/download history for each session. 
There are two types of logs that Xftp keeps. The first type of the logs is the record of file 
management such as renaming, and deletion. The other is the record of the transfer procedure. 
When Xftp runs, new folder is created in the Xftp log folder. Name of the new folder is the date on 
which Xftp is started. In each folder, you will see the file management and transfer procedure logs 
for each session.  

To create log files: 
1. Open the Options dialog box. 
2. Click the Log tab. 
3. Check the Save log messages to files option. 
4. Click OK. 

To delete log files: 
1. Open the Options dialog box. 
2. Click the Log tab. 
3. Click Delete all log files. 

To set the number of days to keep log files: 
1. Open the Options dialog box. 
2. Click the Log tab. 
3. Enter days into the Days to keep logs box. 
4. Click OK. 

To set the log folder: 
1. Open the Options dialog box. 
2. Click the Log tab. 
3. Click the browse ([…]) button in Log folder location. 
4. In the Browse for Folder dialog box, select a folder to save log files into. 
5. Click OK. 
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Managing Window 
Xftp offers many convenient features to manage the Local Folder and Remote Folder windows. 
You can easily rearrange and move between windows. Also, you can set the action to be performed 
when a file is doube-clicked. 

To move between Remote Folder windows: 
1. In the Session tab, click the name of a session. 

 Notes 

You can also move to windows one by one using Ctrl+TAB key. 

To refresh the folder window: 
1. Choose one of the following options: 

• On the View menu, click Refresh. 
• Right-click on the folder window, and click Refresh. 
• On the Toolbar of each folder window, click Refresh. 

To sort the files of a folder window: 
1. Choose one of the following options: 

• On the View menu, point to “Arrange Icons by”. 
• Right-click on the Folder window, and click “Arrange Icons by”. 

To change the double-click action: 
1. Open the Options dialog box. 
2. Click the General tab. 
3. Select an action from the Double-click Action list. 

 Notes 

For detailed information on Double-click actions, see “General tab”. 
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Reference 
This section covers complete reference information for using Xftp. 

Xftp main window 
Xftp main window consists of a number of controls including title bar, menu bar, toolbar,  local 
folder window, remote folder window, transfer window, and status bar. Other than the title bar you 
can hide or show all controls from the View menu. 

 

Figure 4: Xftp Main Window 

File menu 
From the File menu, you can create and open sessions, view the properties of the currently open 
session, and quit the Xftp program.  
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Figure 5: File Menu 

New… 

Opens the New Session dialog box. The keyboard shortcut for New is Ctrl+N. 

New Local Tab 

Opens a new local folder tab. The default local folder opens as a new tab. 

Open… 

Opens the Sessions dialog box. You can list and manage all sessions you created in the dialog box. 
The keyboard shortcut for Open is Ctrl+O. 

Close Tab 

Closes the currently selected Folder window.  

Save As 

Opens the Save As dialog box. It saves all properties of the current session into a new session. 

Import 

Opens Import Sessions dialog box. You can import the session file that is exported from other PC. 

Export 

Opens Export Sessions dialog box. You can export sessions to a single file so that it can be 
imported from other PCs. 

Properties 

Opens the Properties dialog box for the currently open session.  

Exit 

Quits the Xftp program. 
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Edit menu 

 

Figure 6: Edit Menu 

Copy 

Copies selected files. The copied files can be pasted to the Local Folder window or the Remote 
Folder window. The keyboard shortcut for Copy is Ctrl+C. 

Paste 

Pastes the files copied from the Local or Remote Folder window or Windows Explorer to the 
currently active folder window. The copied files are automatically downloaded or uploaded. The 
keyboard shortcut for Paste is Ctrl+V. 

Select All 

Selects all files from the active window. 

View menu  

 

Figure 7: View Menu 

Toolbars 

Opens the Toolbars submenu. 
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Figure 8: Toolbars Submenu 

Menu bar 
Shows or hides the Menu bar. 

Standard buttons 
Shows or hides the Standard buttons. 

Quick Connect bar 
Shows or hides the Quick Connect bar. 

Lock the toolbars 
Allow or disallow changing position of the toolbars. 

Status bar 

Shows or hides the Status bar. 

Transfer Queue 

Shows or hides the Transfer window. 

Session Log  

Shows or hides the Session Log window. 

Large Icons 

Displays each file and folder as a large icon with filename. 

Small Icons 

Displays each file and folder as a small icon with filename. This allows more items to be displayed 
on the folder window than the Large Icons view. 

List 

Displays files in a list of small icons. 

Details 

Displays each file on a separate line with attributes in columns. 

Arrange Icons by 



 

Reference   |   39 

Select in which order the files and folders are listed from the submenu. 

 

Figure 9. Arrange Icons Submenu 

Name 
Arranges the files and folders by their file name. 

Type 
Arranges the files and folders by their file type. 

Size 
Arranges the files and folders by their file size. 

Date 
Arranges the files and folders by the time last modified. 

Refresh 

Refeshes the folder window. 

Command menu 

 

Figure 10: Command Menu 

Transfer Right 

Transfers the selected files from the current window to the window on the right side. 
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Transfer Left 

Transfers the selected files from the current window to the window on the left side. 

Transfer Type 

Sets the type of file transfer. You can choose the transfer type from the submenu. 

 

Figure 11: Transfer Type Submenu 

ASCII 
Transfer files in ASCII mode. 

Binary 

Transfer files in Binary mode. 

Auto 

The Transfer type is determined by the file extension. If a file has an extension which is listed 
on ASCII Extensions, the file is transferred in ASCII type. For more information about ASCII 
Extensions, see ASCII Extensions dialog box. 

Date Connection Type 
Sets the connection mode of FTP server when the data connection is established. You can choose 
the connection mode from the submenu. In the SFTP session, there is no need to set this mode. 

 

Figure 12: Data Connection Type Submenu 

Passive 
The FTP server waits for Xftp to establish the data connection. If you are inside a firewall, 
choose Passive mode. 

Active 

Your PC waits for the FTP server to establish the data connection. If you are inside a filewall, 
file transfer may fail in Active mode. 

New Folder 

Creates a new folder on the current folder window. 

Rename 
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Changes the name of the selected file on the current folder window. 

Delete 

Deletes the selected files on the current folder window. In the Local folder window, if you select 
Delete with Shift key pressed, the files will be deleted permanently. Otherwise, those will be sent 
to Recycle Bin. 

Change Permissions 

Opens the Change Permissions dialog box to change the permissions of the selected file on the 
Remote Folder window. 

RAW Command 

Opens the FTP RAW Command dialog box. The Raw Command is defined as ‘FTP service 
commands’ in RFC959 and the command such as ‘LIST’ can be passed to the server using this 
dialog box. 

Tools menu 

 

Figure 13: Tools Menu 

Host Key Manager 

Opens the Host Keys dialog box. 

User Key Manager 

Opens the User Keys dialog box. 

User Key Generation Wizard 

Opens the User Key Generation Wizard. 

Synchronize Folders 

Opens the Synchronization dialog box. You can use the Synchronize feature to synchronize the 
local and remote folder that are currently open.  

Options 

Opens the Options dialog box. The dialog box allows you to customize global options that are 
applied to all sessions you have created. 
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Window menu 

 

Figure 14: Window Menu 

New File Transfer 
Opens a new Xftp window. If this menu is selected while a session is connected, Xftp attemps to 
make a connection with the current session information. 

New Terminal 
Opens a terminal window from the current session using Xshell®.. 

 
 

New Vertical Tab Group 
Creates a new tab group on the right side of the current tab group and place the selected tab in 
the new tab group.  

Close All Tabs 
Closes all tabs.  

List of connections that are currently open 

At the bottom of the Window menu, there is a list of currently open Remote Folder windows. 
These windows are listed in chronological order of creation, so the window created first will be on 
top of the list. You can move to another window by just clicking a session in the list. The name of a 
session indicates the title of the corresponding window. 
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Help menu 

 

Figure 15: Help Menu 

Xftp Help 

Opens the Xftp Help system. 

Visit Xftp Web Site 

Opens official Xftp website on the default web browser. On our website, you can find the latest 
release, updates and support information. 

Visit Xftp Online Forum 
Opens the online Xftp open forum on the default web browser. You can post any comments or 
questions about Xftp on the forum. There is no sign up and it’s free.  

Check for Updates 
Checks the newest version of Xftp to help with upgrading it. 

Register Xftp 
Opens the Xftp registration dialog box in which you can enter your license key. 

About Xftp 
Opens the About Xftp dialog box that contains information about Xftp and license. 

Toolbar buttons 
Xftp provides a number of toolbar buttons for commonly used tasks and commands. You can also 
perform the same task from the menu bar or session Properties dialog box. 

 

Figure 16: Toolbar Buttons 

The list below describes the toolbar buttons. 

Button Name Description 

 New Opens the New Session dialog box. 
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 Open Opens the Sessions dialog box. 

 Disconnect Closes the connection. 

 Reconnect Reconnects the disconnected session. 

 
Properties Opens the Properties dialog box of the current session or the 

default session if Xftp is not connected. 

 
Run Opens the selected files with associated program. You can also set 

the default Text Editor under the Advanced tab of Options dialog 
box. 

 Transfer Right  

 Transfer Left  

 
Synchronize Opens the Synchronization dialog box. You can set synchronizing 

options and start synchronizing folders. 

 Copy Copies the selected files and folders. 

 Paste Pastes the selected files and folders. 

 New Terminal Opens a new terminal window using the authentication information 
of the currently selected tab. 

 New File Transfer Opens a new file transfer window using the authentication 
information of the currently selected tab. 

 Options Opens the Options dialog box. You can set Xftp global options 
here. 

 Help Opens Xftp Help. 

Quick Connect bar 

 

Figure 17: Quick Connect Bar 

The syntax for the Address field is: 

 [protocol://][user@]hostname[:port][/] 

Available protocols are sftp, ftp, SSH and TELNET. The default protocol is the one that is specified 
in the default session. The default ports used by the protocols are defined as following: 

• sftp: 22 

• ftp: 21 

Some examples are listed below. 

Usage Description 
foobar.com Connects to the foobar.com with the protocol and 

port specified in the default session. 
sftp://kay@foobar.com/ Connects to the foobar.com with the sftp protocol. 

User account is kay and the default port 22 will be 
used. 
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sftp://kay@foobar.com:12345/ Connects to the port 12345 of foobar.com with the 
sftp protocol. The user account is kay. 

ftp://foobar.com/ Connects to the foobar.com with the ftp protocol. A 
user is not defined and the default port 21 will be 
used. 

 Notes 

Xshell will open when SSH and TELNET protocols are used. 

Links bar 
Links bar allows easier access to those sessions that are frequently used. 

 

Figure 18: Links bar 

Add button 
The Add button allows you to add the current session on the Links bar quickly. To add a new Links 
session, click on the remote window and click on the Add button on the Links bar.   

Session Tab 
Session tab displays the currently open sessions and lets you select a session to work with. 

  

Figure 19: Session Tab 

New Local Tab 

Opens a new local tab on the right side of the current window. If the default local directory is not 
configured, user’s Desktop opens.  

Duplicate 
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Duplicates the currently selected remote tab. Duplicated session is created on the right side of the 
currently selected tab. 

Rename 
Changes the name of the selected session. 

Close 
Closes the selected session. 

Close All  
Closes all sessions from the current tab group. 

New Vertical Tab Window 

Creates and moves the selected tab to a new vertical tab group. New tab will appear on the right 
side of the currently selected tab. 

Move to Next Tab Group 
Moves the selected session to next tab group. 

Move to Previous Tab Group 
Moves the selected session to previous tab group. 

Local Folder window 
The Local Folder window displays files and folders of your local computer like Windows Explorer. 
In the Local Folder window, you can create a new folder, delete files, view the properties of a file, 
and upload files. With the Local Folder tab, you can easily switch between the local folders. 

 

Figure 20: Local Folder Window 

Local Folder Tab 

Users can assign a different folder for each tab. By having multiple local folders open in the tab, 
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users can switch between the local folders more easily. 

 

Figure 21: Local Folder Tab Menu 

New Local Tab 

Opens a new local tab on the right side of the current window. If the default local directory is 
not configured, user’s Desktop opens. 

Close 

Closes the selected local folder tab. 

Close All  
Closes all sessions from the current tab group. 

New Vertical Tab Window 

Creates and moves the selected tab to a new vertical tab group. New tab will appear on the 
right side of the currently selected tab. 

Move to Next Tab Group 
Moves the selected session to next tab group. 

Move to Previous Tab Group 
Moves the selected session to previous tab group. 

Name 

Displays the name of a file or folder. 

Size 

Displays the size of a file. The size of a folder is not applicable. 

Type 

Displays the type of a file according to its extension. 

Modified 

Displays the last modified date. 
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Local Folder Window Menu 

 

Figure 22: Local Folder Window Menu 

Transfer  

Transfers the selected files to local or remote folder. If there are more than 2 tab groups, Xftp 
opens the Transfer Destination dialog box. You can choose which folders Xftp should transfer the 
files to. 

Queue 

Adds the selected files to the transfer queue. Pending transfers can be started manually by users.  

Upload to All Remote Sessions 

Transfers the selected files and folders to all open remote sessions.  

Open 

Excutes the selected file with the program associated with the file extension. If the selected file is a 
folder, then the selected folder is open in Windows Explorer. 

Open With Explorer 
Opens the current folder with Windows Explorer. 

Edit 

Opens the selecte file with the default text editor. If the default text editor is not configured on 
Options, Xftp opens the selected file with Windows Notepad. 

Copy 

Copies the selected files. The copied files can be pasted to Window Explorer or the Remote 
Folder window. Files are automatically uploaded when pasted in to the Remote Folder window. 

Paste 

Pastes the files copied from the Remote Folder window or Windows Explorer to the currently 
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active Local Folder window. The copied files or folders from the Remote Folder window are 
automatically downloaded. 

Rename 

Changes the name of the selected file. 

Delete 

Deletes the selected files and sends to Recycle Bin. If you select Delete while holding the Shift key 
down, then the files will be deleted permanently. 

Properties 

Shows the properties information of the selected file. 

View 

Displays the contents of a folder as large icons, small icons, lists, or details. 

Arrange Icons by 

Arranges the files and folders by their filename, size, type, or the time last modified. 

Select All 

Selects all files from the active window. 

Refresh 

Updates the contents of the active window. 

Paste 

Pastes the files copied from the Remote Folder window or Windows Explorer to the currently 
active Local Folder window. The copied files or folders from the Remote Folder window are 
automatically downloaded. 

New Folder 

Creates a new folder. 

Properties 

Shows the property information of the current directory. 

Remote Folder window 
The Remote Folder window displays the files on the remote system. In the Remote Folder 
window, you can create a new folder, delete files, view the properties of a file, and download files. 
You can find the Remote Log pane on the bottom of the Remote Folder window. The Remote 
Log pane displays the connection logs for the session. 



 

Reference   |   50 

 

Figure 23: Remote Folder Window 

Name 

Displays the name of a file or folder. 

Size 

Displays the file size. The size of a folder is not applicable. 

Type 

Displays the type of a file according to its extension. 

Modified 

Displays the last modified date. 

Attributes 

Displays the file attributes (such as hidden or read-only). 

Owner 

Displays the owner of a file or folder. 

Remote Folder Tab 

Users can assign a different folder for each tab. By having multiple local folders open in the tab, 
users can switch between the local folders more easily. 
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Figure 24: Remote Folder Tab Menu 

New Local Tab 

Opens a new local tab on the right side of the current window. If the default local directory is 
not configured, user’s Desktop opens. 

Duplicate 

Makes a new connection of the selected session in the new tab. 

Rename 

Renames the selected tab. 

Close 

Closes the selected local folder tab. 

Close All  
Closes all sessions from the current tab group. 

New Vertical Tab Window 

Creates and moves the selected tab to a new vertical tab group. New tab will appear on the 
right side of the currently selected tab. 

Move to Next Tab Group 
Moves the selected session to next tab group. 

Move to Previous Tab Group 
Moves the selected session to previous tab group. 
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Remote Folder Window Menu 

 

Figure 25: Remote Folder Window Menu 

Transfer  

Transfers the selected files to local or remote folder. If there are more than 2 tab groups, Xftp 
opens the Transfer Destination dialog box. You can choose which folders Xftp should transfer the 
files to. 

Queue 

Adds the selected files to the transfer queue. You can start downloading the files in the transfer 
queue at anytime you want. 

Open 

Excutes the selected file after downloading it. 

Edit with User Defined Editor 

Opens the selected file with the program defined in Xftp after downloading it. The file is 
automatically uploaded when you save the changes. 

 Notes 

For more information about User Specified Editor, see “Options dialog box, Advanced Tab”. 

Copy 

Copies the selected files. The copied files can be pasted to the Local Folder window. 

Paste 

Uploades the files copied from the Local Folder window or Windows Explorer to the currently 
active Remote Folder window. 

Rename 

Changes the name of the selected file. 
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Delete 

Deletes the selected files  

Change Permissions… 

Opens Change Permissions dialog box to change the permissions of the selected file. 

Properties 

Shows the property information of the current directory. 

View 

Allows you to show or hide Log Window or choose to display folder items as large icons, small 
icons, lists, or details. 

Arrange Icons by 

Arranges the files and folders by their filename, size, type, or the time last modified 

Select All 

Selects all files from the active window. 

Refresh 

Updates the contents of the active window. 

Paste 

Uploads the files copied from the Local Folder window or Windows Explorer to the currently 
active Remote Folder window. 

New Folder 

Creates a new folder. 

Properties 

Shows the property information of the current directory. 

Transfer window 
The Transfer window shows file lists and transfer status as Ready, Transferring, Paused, or 
Finished. Also, it shows the logs of all transfer processes. By using Transfer window menu, the 
user can easily monitor or manage files in transfer. 

 

Figure 26: Transfer Window 

Name 

Displays the name of a file or folder. 
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Status 

Displays the file transfer status. 

Ready 

The file is ready to be transfered. 

Transferring 

The file is currently being transferred. 

Paused 

The file tansfer is paused. 

Finished 

The file transfer is successfully completed. 

Error 

Faild to transfer for some reason. To see the reason of failure, refer to “Transfer Status dialog 
box”. 

Progress 

Displays the percentage of the total file size transferred in relation to the actual file size. When you 
transfer a folder, the percentage may decrease as the transfer proceeds. 

Size 

Displays actual or transferred file size. When transferring a folder, displayed size of a folder may 
increase as transfer proceeds. 

Local Path 

Displays the local folder of the file being transferred. 

<-> 

Displays the transfer mode: upload or download. The ‘->’ means upload and the ‘<-’  indicates 
download. 

Remote Path 

Displays the remote folder of the file being transferred. 

Speed 

Displays the file transfer speed in Kilobytes per second. When you transfer a folder, the transfer 
speed may be shown lower than the network speed. 

Left 

Displays the estimated remaining time for completing the file transfer. 
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Transfer window menu 

 

Figure 27: Transfer Window Menu 

Open 

Excutes the selected file. 

Pause 

Stops selected file transfers. 

Pause All 

Stops all file transfers. 

Resume 

Resumes selected file transfers from Pause. 

Resume All 

Resumes all file transfers from Pause. 

Remove 

Cancels and removes selected file transfers. It does not remove the files already created. 

Remove All 

Cancels and removes all file transfers. It does not remove the files already created. 

Remove Finished 
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Removes all records of finished file transfer from the Transfer window.  

 Notes 

If you want to automatically remove the record of finished transfers, see “Options dialog box, 
General tab”. 

Restart All Failed 

Restarts all failed transfers. 

Restart Transfer 

Restarts transfer of the selected files and folders.  

Status 

Opens the Transfer Status dialog box. 

Action After All Transferred 

Select what to do after all transfers are completed from the submenu. 

 

Figure 28: Actions Submenu 

Do Nothing 

Does nothing. 

Log Off 

Logs off the user’s Windows session. 

Shut Down 

Shuts down the computer. 

Log window menu 

 

Figure 29: Log Window Menu 

Copy 
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Copies the selected area of the Log window to the clipboard. 

Clear 

Deletes all contents of Log window. 

Select All 

Selects all contents of Log window. 

Status bar 

 

Figure 30: Status Bar 

The status bar shows the status messages of the Xftp window. The connection status information 
is shown here. 
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Synchronization dialog box 

 

Figure 31: Synchronization dialog box 

Local Directory 

Select a local directory to sychronize with a remote folder. 

Active Session 

To set a remote direcotry to synchronize with, you must select a remote session from the currently 
open remote tabs.  

Remote Directory 

Type a remote folder path to sychronize with a local folder. By default, currently open folder is 
enterred for you.  

Sync Direction 

Choose from different sycnrhonize modes. 

• Local to Remote: Xftp finds the files that are more recent on the local folder and uploads 
them to the remote folder.  

• Remote to Local: Xftp finds the files that are more recent on the remote folder and 
dowloads them to the local folder.  

• Synchronize: Xftp finds the files that are more recent on either end of the transfer and 
transfer them to the other side.  
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Overwrite if the file exists 
Choose this option to overwrite files if they exist in the destination folder. If the option is not 
selected, Xftp will prompt for user input when the same file is found in the destination folder. 

Only on Local 

Choose an action to perform if the file only exsists on the local folder. 

Only on Remote 

Choose an action to perform if the file only exsists on the remote folder. 

Synchronization Options dialog box 

 

Figure 32: Synchronization Options Dialog Box 

Include Subdirectories  

Select this option to do recursive synchronization to all child folders. 

Show files that are not going to be synced  

Displays the files that will be excluded from sync on the Sync Review window. 

Do case sensitive comparison  

Select this option to perform case senstivive compariosn. For example, if this option is enabled, 
Xftp considers ABC.txt and abc.txt as the same file.  

Show list of files/folders before sync 
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Select this option to review the files that are going to be sync before the sync begin.  

Exclude the following files 

Type in the file extensions or filenames that are going to be excluded from the sync. 

Default Local Directory 

Select the default local directory for the synchronize feature.  

Remember my settings 

Save the current settings and apply the same settings in the future. 

Synchronization List dialog box 
 

 

Figure 33: Synchronization Confirmation Window 

Files List 

Shows the list of files that are going to be transferred. If the ‘Show files that are not going to 
be synced’ option is selected, files that are excluded from the sync shows up.  

Transfer Now 

Xftp starts synchronization when this button is pressed. 

Queue 

Xftp adds the files that need to be synchronized to the Transfer Queue. Synchonization does not 
begin until you give the Resume command on the Transfer Queue.  

Sessions dialog box 
The Sessions dialog box allows you to create and manage sessions. By default the dialog box 
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opens automatically when Xftp starts. You can also open it by clicking Open on the File menu. 

 

Figure 34: Sessions Dialog Box 

A session holds information that Xftp uses when connecting to a remote host. By creating sessions, 
you can save your efforts to enter the remote hostname and other required information if you are 
connecting to a specific computer frequently. 
The toolbar contains a number of buttons to manage sessions. 

Button Name Description 

 New Opens the New Session dialog box. 

 Save As Saves the selected session as another name. 

 Cut Cuts the selected sessions and saves to the clipboard. 

 Copy Copies to the clipboard. 

 Paste Saves the sessions in the clipboard to the current folder. 

 Delete Deletes the selected session. 

 Properties Opens the Properties dialog box of the selected session. 

 Open Session Folder Opens the current folder in Window Explorer 

 Create a Shortcut Creates a shortcut icon of the selected session. 

 View Type Shows sessions as large icons, small icons, list, or list with 
additional columns. 

Shows this dialog box at startup 
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If this box is checked, Xftp opens the Sessions dialog box automatically when it starts. You can 
clear the check box not to use this feature. 

Connect 

Connects to a remote computer using a selected session and closes the dialog box. 

Close 

Closes the dialog box. 

 Notes 

Xftp also supports a Default Session that can be used when you connect to a remote 
computer without opening a saved session. You cannot open and edit the default session in 
this dialog box. To change the default session, click Properties on the File menu when Xftp is 
not connected to any remote computer. 

Session Menu 
From the Session dialog box, right click on the session list to display the Session menu. Selecting a 
menu item or clicking a button from the toolbar has the same effect. For description on each menu 
item, please refer to the toolbar table above. 
 

 

Figure 35: Session Menu 

New Session dialog box  
The New Session dialog box allows you to create a new session. You can open the dialog box by 
clicking New on the File menu or New button on the Sessions dialog box. 
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Figure 36: New Session Dialog Box 

It is the same as Properties dialog box except for the editable session name box. Initial values are 
configured as the values of the default session. To edit the default session, click Properties on the 
File menu when there is no connection established. 
For detailed information about configuring this dialog box, see the “Properties dialog box” below. 

Properties dialog box  
The Properties dialog box allows you to customize the settings of a session. You can open it by 
clicking Properties on the File menu or Properties button on the toolbar. 
The values set in this dialog box are saved in the session file, and you can open it later to connect 
to the remote computer with the same options. 
The Properties dialog box contains General and Options tabs to subdivide options into related 
groups. 
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General tab 
In the General tab, you can set values related to the connection of a session. In most cases, you 
need to configure only this tab to connect to a remote computer. 

 

Figure 37: Properties Dialog Box 

Name 
Enter a unique name for this session.  

 Notes 

The name is used as filename, so you should enter only valid characters. 

Host 

Enter the hostname or IP address of a remote computer. 

Protocol 
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Select the connection protocol you want to use. The protocol should be serviced by the remote 
computer. Xftp supports FTP and SFTP protocols. 

Setup 

When SFTP protocol is selected, more detailed options can be set. For more information, see 
“Advanced SFTP Options Dialog Box”.  

Port Number 

Enter the port number of the protocol selected above. When you select a protocol from the 
Protocol list, the default port of the selected protocol is automatically entered into the box. If the 
remote computer uses another port for the protocol, you must enter a correct one. The default FTP 
and SFTP port numbers are 21 and 22 respectively. 

Proxy Server 

Select a proxy server for the session. 

Anonymous Login 

Login as anonymous user. This is supported only for the FTP protocol. 

Use authentication agent 
Select this check box when you want to use Xagent for SFTP protocol. Xagent is an SSH 
authentication agent. Xagent makes it more convenient to use private keys. This menu is only 
available when Xshell™ is installed. 

Method 

Select a user authentication method to be used in the remote computer. 

User Name 

Enter a user name you want to log on. The user name is an account name on the remote computer. 
If you leave it blank, a prompt dialog box for a user name will appear when making the connection. 

Password 

Enter the password of the user account on the remote computer. It is used when a Password 
authentication is selected. If this box is blank, a prompt dialog box will appear during logon 
process. The password is encrypted and saved in your PC. For better security, just leave it blank. 

User Key 

Select the user key that will be used when the Public Key authentication of SFTP protocol is 
selected. If this box is blank, a prompt dialog box will appear when required. If there is no user 
key in the list, you should create a new key and register it to the remote SSH server. 

Passphrase 
Enter the passphrase of the user key you have selected. It is encrypted and saved in your PC. For 
better security, just leave it blank. 

Options tab 
In the Options tab, you can set more detailed options for the session. Most users do not need to 
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make changes for these options. 

 

Figure 38: Properties, Options tab 

Host Type 
Select an operating system of the remote computer. If you do not know what to select, select Auto 
Detect. 

Use UTF-8 encoding 

Communicate with the remote computer using UTF8 string. If the remote computer uses UTF8 
string and the remote files are encoded in UTF-8, then you must use this option. 

Send keep alive messages 
Sends keep alive messages to the remote computer. It is useful when the connection is terminated 
unexpectedly when it is idle. In some network environments, a gateway or a firewall system may 
terminate connections without notice when the connections are idle for the specified time period. 
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Use passive mode 

When files are transferred, if the Passive Mode is set, the remote computer waits for your PC to 
establish the data connection. For detailed information, see the Connection Type of “Command 
menu”. In case of SFTP connection, there is no need to set this option. 

Transfer Type 

Set the transfer type in this session. For detailed information, see the Transfer Type of Command 
menu. 

Multiple Transfers 

Set the number for multiple simultaneous transfers. This option is useful when servers allow 
multiple connections. 

Use main connection only 

This option is useful when the server allows only one connection. If this option is selected, 
transfers will be executed one at a time, and some actions on the remote folder will be limited 
during the transfers. In case of using SFTP connection, there is no need to set this option. 

Local 

Set the local initial folder displayed when the connection is established for the session. 

Remote 

Set the remote initial folder displayed when the connection is established for the session. 

Advanced SFTP Options Dialog Box 
In the Advanced SFTP Options dialog box, users can set options for using the SFTP protocol. 
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Figure 39: Advanced SFTP Options Dialog Box 

Encryption 

Encryption algorithms are used to encrypt and decrypt network traffics. You can select a preferred 
encryption algorithm in the list. When you select the <Cipher List>, multiple algorithms are tried in 
the order appeared in the list. To edit the <Cipher List>, click Edit. 

MAC (Message Authentication Code) 

A MAC is a new feauture in SSH2. It ensures data integrity and provides increased security over 
SSH1. You can select a preferred MAC algorithm in the list. When you select the <MAC List>, 
multiple algorithms are tried in the order appeared in the list. To edit the <MAC List>, click Edit. 

Use zlib compression 

Select this check box to compress all data traffic over an SFTP connection. A compression method 
will provide better performance over a slow network environment. 
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Host Keys dialog box 
The Host Keys dialog box allows you to manage the host keys collected from remote hosts. You 
can open it by clicking Host Key Manager on the Tools menu. 

 

Figure 40: Host Keys 

A host key is the public key of a remote host and you can check the fingerprint on the key to verify 
the validity of the host. The remote host sends its public key to Xftp when the connection is 
established. When the host key is valid and you trust it, you can save the host key to the database 
in Xftp. If the host key is not saved in the database, the SSH Security Warning dialog box will 
appear when you try to connect to the host. 
Be sure that the fingerprint on the host key is exactly the same as the one on the host which you 
want to connect. 

Import 

Opens the Open dialog box to import a host key. An imported key will be saved into the database 
and listed in the Host Keys dialog box. Xftp can import the keys formatted as SECSH Public Key 
Format. 

Export 

Opens the Save dialog box to export the selected host key. An exported key will be saved as a file, 
and you can use it with other programs. The exported file is formatted as SECSH Public Key 
Format. 

Remove 

Removes the selected host key from the database. 

View 
Opens a Notepad window with the contents of the selected host key. 
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User Keys dialog box 
The User Keys dialog box allows you to create and manage user keys. You can open it by clicking 
User Key Manager on the Tools menu. 

 

Figure 41: User Keys 

A user key is comprised of two keys, a public key and a private key. The public key is registered to 
the remote server, and the private key is saved locally for Xftp. When the public key 
authentication is in progress, the public key is sent to the server. If it is found on the server, the 
connection will be allowed. 
You can create a user key with the User Key Generation Wizard provided by Xftp or the key 
generation tool on the remote server. When the user key is created on the server, you should get 
the private key from the server and import it on the User Keys dialog box . When the user key is 
created on Xftp, you should register the public key to the remote server. Transferring a private key 
over the network is not recommended and it is more secure to create it on Xftp and register the 
public key to the server. 

Import 

Opens the Open dialog box and saves the selected user key file in the user key database. 
Currently Xftp can import SSH1-RSA, OpenSSH2-RSA, OpenSSH2-DSA, SSH.COM key, and 
NetSarang User Key formats. 

Export 

Opens the Save dialog box and saves the selected user key as a file. The private key file is saved 
in NetSarang User Key format and it cannot be used with the programs provided by other vendors. 

Delete 

Deletes the selected user key from the database. 

Rename 



 

Reference   |   71 

Changes the name of the selected user key. 

Properties 

Shows the properties information of the selected user key. You can see the type, length, fingerprint, 
and public key of the selected key. Also you can change the passphrase of the key. 

Generate 
Opens the User Key Generation Wizard. 

User Key Properties dialog box 
The User Key Properties dialog box shows you the properties information of the selected user 
key. It also allows you to change the passphrase of the key and save the public key as a file. You 
can open the dialog box by opening the User Keys dialog box, selecting a user key, and then 
clicking Properties. 

General tab 
The General tab shows the type, length, and fingerprint of the user key. You can change the name 
and passphrase of the key. 

 

Figure 42: User Key Properties Dialog Box, General Tab 

Key Name 
Displays the name of the user key. You can change the name when necessary. The name should 
have only valid characters for being a filename. 
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Change Passphrase 
Click this button to change the passphrase of the user key. 

Public Key tab 
The Public Key tab shows the public key part of the user key. You can save the public key as a file 
with the format you have selected. 

 

Figure 43: User Key Properties, Public Key Tab 

View public key format as 
Select a public key format in the list. Currently supported formats are SSH2-OpenSSH, SSH2-IETF 
SECSH, and SSH1. 

Save as a file 
Opens the Save As dialog box. You can save the public key in a file and register it to the SSH 
server. 

User Key Generation Wizard 
The User Key Generation Wizard dialog box allows you to create DSA or RSA user keys step by 
step. You can open it by clicking User Key Generation Wizard on the Tools menu. 

Step 1: Key Generation Parameters 
This step allows you to select the type and length of the user key. 
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Figure 44: User Key Generation Wizard, Key Generation Parameters 

Key Type 
Select DSA or RSA in the list. SSH1 protocol supports only RSA keys and SSH2 protocol supports 
both RSA and DSA. You should select the one that is supported by the remote server. 

Key Length 
Select a key length in the list. Longer keys provide better security while shorter keys provide 
better performance. The optimal key length for most applications is 1024 bits. 

Step 2: Public Key Pair Generation 
This step generates a user key with the parameters selected in the previous step. 
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Figure 45: User Key Generation Wizard, Public Key Pair Generation 

After the key has been generated successfully, you can click the Next button. 

Step 3: User Key Information 
This step allows you to enter the name and passphrase of the user key. 
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Figure 46: User Key Generation Wizard, User Key Information 

Key Name 
Enter the name of the user key generated. The user key is saved as the name entered here and 
the name must have only valid characters as a filename. 

Passphrase 

Enter the passphrase of the user key. It is used every time when you open it and you must 
remember it. 

Confirmation 
Enter the same passphrase again to confirm it. 

Step 4: Public Key Registration 
This step allows you to register the public key part of the user key to a remote server. You can also 
register it later from the  User Keys dialog box. The private key is stored in the User Keys 
database of Xftp. 
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Figure 47: User Key Generation Wizard, Public Key Registration 

Public Key Format 
Select one of the formats (SSH1, SSH2-OpenSSH, and SSH2-IETF SECSH) from the list. The text 
box below shows you the public key in the selected format. You can copy the text and store it as a 
file on the remote server. Depending on the server, steps needed to register the public key are 
different. In most cases, the following guideline will work for each format. 

• SSH1: Copy the text and save it to $HOME/.ssh/authorized_keys file. Run the following 
commands to turn off the write permission of the files and directories: 
$ cd 
$ chmod go-w . .ssh .ssh/authorized_keys 
 

• SSH2-OpenSSH: OpenSSH servers use this format. Copy the text and save it to 
$HOME/.ssh/authorized_keys2 file. Run the following commands to turn off the write 
permission of the files and directories: 
$ cd 
$ chmod go-w . .ssh .ssh/authorized_keys2 
 

• SSH2-IETF SECSH: Some commercial SSH servers such as ssh.com's use this format. 
Copy the text and save it to a unique name such as mypublickey.pub in the $HOME/.ssh2 
directory. And then add a line into the $HOME/.ssh2/authorization file such as “Key 
mypublickey.pub”. Run the following commands to turn off the write permission of the 
files and directories: 
$ cd 
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$ chmod go-w . .ssh2 
$ chmod go-w .ssh2/authorization .ssh2/mypublickey.pub 

SSH Security Warning dialog box 
The SSH Security Warning dialog box appears automatically when you try to connect to the host 
when its host key is not saved in the Host Keys database. 

 

Figure 48: Security Warning 

It shows the fingerprint of the host key and you can follow one of three actions: 

• Accept Once 

• Accept & Save 

• Cancel 

Accept Once 
Accepts the host key and connects to the host only for this time. The host key is not saved in the 
database, and you will see the same dialog box for the same connection next time. 

Accept & Save 

Saves the host key in the database and connects to the host. The SSH Security Warning dialog will 
not show up next time. You can choose this command when the fingerprint is correct and you 
connect to the host frequently. Be sure that you should remove the key from the database when 
the remote host has changed its host key. 

Cancel 
Rejects the host key and cancels the connection. 

SSH User Authentication dialog box 
For sessions using SFTP connection method, the SSH User Authentication dialog box allows you 
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to choose an appropriate authentication method. It is displayed automatically when user 
information is required to proceed further. 

 

Figure 49: SSH User Authentication 

If a user authentication method is not allowed from the remote host, it appears dimmed. To use 
the unavailable method, you must configure the SSH server in the remote host. 

Password 

The Password authentication allows you to log on using the password of your account on the 
remote host. For the security reason, some hosts do not allow this authentication method. 

Public Key 

The Public Key authentication requires a public key to be registered on the remote SSH server. To 
log on with this method, you should select the corresponding private key in the User Key list. 

Keyboard Interactive 
The Keyboard Interactive (Generic Message Exchange) authentication prompts instructions to 
enter authentication messages for further steps. 

FTP User Authentication dialog box  
The FTP User Authentication dialog box allows you to input the account name and password for the 
FTP connection.  
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Figure 50: FTP User Authentication Dialog Box 

User Name 

Enter the name of your account to login. 

Password 

Enter the password of the account. 

Anonymous Login 

Select this check box to login as anonymous user. 

File Exists dialog box 
The File Exists dialog box allows you to select the action to perform when the file to be 
transferred already exists in the target folder. 
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Figure 51: Download File Exists Dialog Box 

Name 

Displays the name of a file or folder to be transferred. To change the name, select Rename from 
the Action list box. 

Action 

Select the action to perform if the same file name already exists in the target folder. 

Overwrite 

Overwrites the existing file. 

Ignore 

Ignores the file to be tranferred and the existing file remains unchanged. 

Resume 

Appends to the existing file. The existing file should be smaller than the file to be transferred. 

Rename 

Changes the name of a file to be transferred. 

Apply to all 

Applies the selected action to all other remaining files to be transferred. 
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Transfer Status dialog box 
The Transfer Status dialog box provides a detailed status of a file or folder being transferred 
including a list of failed transfers along with the reasons for such a failure. To open this dialog box, 
right-click on a transfer from the Transfer window and then click Show Transfer Status. 

 

Figure 52: Transfer Status Dialog Box 

Change Permissions dialog box 
The Change Permissions dialog box allows you to change the premissions of a file located on the 
remote computer. 

 Notes 

The permission change may not work for some remote computers. 
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Figure 53: Change Permissions Dialog Box 

File/Folder Permissions 

Enter the digits expressing the permissions of a file or folder. 

Owner 

Set the permissions for the owner of a file or folder. 

Group 

Set the permissions for the group of a file or folder. 

Others 

Set the permissions for the others of a file or folder. 

Read 

The Read permission allows a file to be read. The Read permission for a folder means that a user 
may browse the contents of the directory. 

Write 

The Write permission allows the contents of a file to be altered. The Write permission for a folder 
means that a user may create files in the directory.  

Execute 

The Execute permission allows a file to be executed. The Execute permission for a folder means 
that a user may enter the directory. On FTP connection, to retrieve the file list of a folder, you must 
have the Read and Execute permissions for the folder. 

Options dialog box 
The Options dialog box allows you to customize the global options that will be applied to all 
sessions. You can open it by clicking Options on the Tools menu. 
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The Options dialog box contains three tabs to subdivide options into related groups. 

General tab 
The General tab has a number of options for general behavior of the Xftp window. 

 

Figure 54: Options Dialog Box, General Tab 

Show Sessions dialog box at startup 

Opens the Sessions dialog box automatically when Xftp starts. You can also open it by clicking 
Open on the File menu. 

Delete finished transfer logs 

Deletes a record for a successful transfer from Transfer window. 

Use Natural Order Sort 

When sorting by name on the Local or Remote Folder window, with this option off, file10 comes 
before file9.  It is recommended to set this option on, when sort files with digits. 
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Convert to valid name automatically  

When this option is on, invalid filenames are automatically converted to valid Windows filenames. 
If this option is off, you can not download the files containing invalid characters for Windows. 

Show files start with “.” character 

Displays the files starting with “.” on the Remote Folder window. The files starting with “.” on the 
Unix system are regarded as hidden files. 

Show welcome message 

Display the welcome banner in case the FTP server provides one. 

Display full path in the local address bar 

Displays the full path in the local address bar instead of just the folder name. 

Use Home(~) path as SFTP default directory 

Uses the tilda(~) sign as home directory indicator for SFTP connections. Only use it if you have 
problem opening to folders of SFTP sessions that are open from Xshell. 

Use FXP protocol for FTP server to FTP server transfer 

When this option is enabled, Xftp uses FXP protocol to trasnfer files between FTP servers. To use 
this feature, the FTP servers must enable the FXP feature. FXP allows to transfer files between two 
FTP server directly without caching the file on the local folder.  

Double-click Action 

Select the action to perform when double clicking on the file of the Local or Remote Folder 
window from the submenu. 

Upload 
Uploads the file. 

Download 
Downloads the file.  

Open 

Opens or executes the file. 

Properties 

Displays the Properties of the file. 

On Startup tab 
The On Startup tab allows you to configure Startup options. 
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Figure 55: Options Dialog Box, On Start Tab 

 

On Startup 

Open the default local folder: Xftp opens only one local folder tab when it starts.  

Reopen the tabs that were open last: Xftp opens the tabs that were open before closing the last 
Xftp window.   

Default local folder 

Select the default local folder. This folder is open in new tab when “New Local Tab” is selected.  

Transfer tab 
The Transfer tab allows you to configure options for file transfer. 
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Figure 56: Options Dialog Box, Transfer Tab 

ASCII Extensions 

Register the file extensions for the ASCII text files. If you select the Transfer Type to 
Auto, the files with the registerd extension will be transferred in the ASCII transfer type. 
For detailed information, see the Session Folder 

Select a folder to save Xftp sessions.  

Temporary Folder 

Select a temporary cache folder you want to save temporary files. Xftp deletes files in this folder 
when exits.  

ASCII Extensions dialog box. 

Transfer Options 

Setup the advanced options for file transfer.  
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Log tab  
The Log tab allows you to configure options for the connection and transfer logs. 

  

Figure 57: Options Dialog Box, Log Tab 

Maximum Lines 

Sets the maximum line number for the Remote Log window. 

No limit 

Sets the line number of the Remote Log window unlimited. 

Save log messages to files 

Saves the connection and transfer logs to files.  

 Notes 

To find the log files, click the “Browse” button. 
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Days to keep logs 

Sets the period to keep the log files.  

 Notes 

After the specified period, the log files will be deleted when Xftp starts or every 24 hours after 
the Xftp has been started. 

Delete all log files 

Deletes all log files in the log folder. 

Log folder location 

Changes the folder location where the log files are saved. 

Browse 

Opens the folder where the log files are saved. 

Advanced Tab  
In the Advanced tab, users can choose an editor that will be used when opening remote files. 
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Figure 58: Options Dialog Box, Advanced Tab 

Use Notepad as text editor 

Uses Windows Notepad as the user defined editor for editing files in the Remote Folder window. 

Editor Path 

Enter the full path to your preferred editor. Selecting this option will replace Notepad for editing 
files in the Remote Folder window. Click Browse and select an executable of the editor file from 
the dialog box. 

Editor Name 

Type the name of selected editor. This name is shown on the remote folder window menu. 

Session Folder 

Select a folder to save Xftp sessions.  

Temporary Folder 
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Select a temporary cache folder you want to save temporary files. Xftp deletes files in this folder 
when exits.  

ASCII Extensions dialog box 
The ASCII Extensions dialog box allows you to register text file extensions required to be 
transferred in ASCII mode. 

 

Figure 59: ASCII Extensions Dialog Box 

The ASCII Extensions list is used when the Auto is selected for the Transfer Type from the 
Command menu. The files with extensions registered on the list are transferred as ASCII text files. 
If the file’s extension is not registered on the list, it is transferred in binary mode. 

Add 

Adds a file extension to the ASCII Extensions list. 

Remove 

Remove a file extension from the ASCII Extensions list. 

Transfer Options dialog box 
The Transfer Options dialog box allows you to configure the advanced options for file transfers. 
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Figure 60: Transfer Options Dialog Box 

File Overwrite 

Select an action to perform when the file to transfer already exists from the submenu. 

Prompt For Action 
Opens the File Exists dialog box.  

Skip 

Does not transfer the file. 

Resume 
Appends to the existing file. Overwrite it if the existing file size is larger than the size of the file 
to be transferred. 

Overwrite 

Overwrites the existing file. 

File Name 
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Select an action for the file name when the file transfer is successfully completed. 

None 
Does nothing. 

Capitalize 

Changes the first letter of the file name to uppercase. 

Lowercase 
Changes the whole file name to lowercase. 

Uppercase 

Changes the whole file name to uppercase. 

Set timestamp with remote server 

Synchronizes time information of downloaded files with the remote server. 

Transfer Retry 

Sets the number of retry attempts for failed transfer. If the file is transferred successfully, this 
option does not take place. 

Number of retry attempts 

Sets the maximum number of retries until the file is transferred successfully. 

Retry attempt interval 
Sets the delay, in seconds, between retries for failed file transfer. If the delay time is set too short, 
file transfer could be failed again. 

File Properties dialog box 
The File Properties dialog box shows the detailed information of a file on the remote computer. 
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Figure 61: File Properties Dialog Box 

Name 

Displays the name of a file or folder. 

Type 

Displays the type of a file according to its extension. 

Host 

Displays the hostname or IP address of the remote host. 

Location 

Displays the path of a file or folder. 

Size 

Displays the size of a file. In case of a folder, the size is not displayed. 

Contents 

Displays information about file contents. For a folder, displays the number of files in the folder. 

Modified 

Displays the last modification date and time. 



 

Reference   |   94 

Owner 

Displays the owner of a file or folder. 

Group 

Displays the group of a file or folder. 

Permissions 

Displays the permissions to access a file or folder. 

Session Import Wizard 
The Session Import Wizard allows you to import sessions that are created from different 
computers. You can start the wizard by clicking Import from the File menu. 

Step 1: Select import mode 
In this step, choose how you want to import sessions. 

 

Figure 62: Session Import Wizard, Step 1 

From the following location 
Select this option to import the sessions with an exported session file from another computer. 
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Step 2: Importing sessions 
You can view the progress and status of the current import process. 

 

Figure 63: Session Import Wizard, Step 2 

Progress 
You can view the progress of import process. As each session is copied, its result is displayed on 
the screen. Also, number of files imported is summarized at the end of the process. 

Session Export Wizard 
The Session Export Wizard allows you to export sessions. You can start the wizard by clicking 
Export from the File menu. 

Step 1: Select where to save the exported file 
In this step, you can select the name and folder in which the exported file will be saved. 
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Figure 64: Session Import Wizard, Step 1 

Path 
Enter the filename and path in which the exported session file will be saved. 

Step 2: Exporting sessions 
You can view the progress and status of the current export process. 
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Figure 65: Session Export Wizard, Step 2 

Progress 
You can view the progress of export process. As each session is copied, its result is displayed on 
the screen. Also, number of files imported is summarized at the end of the process. 
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Error Messages 
Could not connect to 'hostname'. 

Make sure that the hostname is a valid host name. Check the Log window for a detailed reason 
why the connection is failed. 

Unable to initialize WinSock DLL. Make sure that your WinSock is compatible with 
version 1.1. 
This error might happen when your computer has no LAN interface and/or the network driver or 
TCP/IP module have not been installed. Check if the Internet connection is working properly. 

Could not find the Xftp installation information in the registry. Make sure that the Xftp is 
installed. 
The Xftp was not installed successfully, or the registry information was corrupted. Reinstall the 
Xftp. 

Failed to create user data folder 'folder'. 
You may not have the permission to create a file in the folder, or the disk space may not be 
enough. 

Remote server does not support SSH2 protocol.  
The remote server may support only SSH1 protocol. SSH2 protocol is needed for the connection to 
the remote server via SFTP protocol. 

Failed to compress or decompress outgoing packets. 
This message is displayed when a network error occurs or a hostile attacker modifies network data. 
Try after turning off the zlib compression option in the session properties. 

The server sent an unexpected packet. (expected XXX, got YYY) 
This error occurs when the received packet is not valid or not supported by the current Xftp 
version. For further assistance, send the error message to our support team. 

The server sent an invalid host key. 
The host key of the remote server is invalid or has been corrupted. Make sure that the host key is 
installed correctly in the SSH server. 

The MAC (Message Authentication Code) of a packet is incorrect. 
This message is displayed when a hostile attacker tries to modify network data. Try chaning the 
encryption algorithm to a different one. 

The padding size of a packet is incorrect. 
The packet has been corrupted during transmission. If the problem persists, there may be an 
internal error in the SSH client or server. 

No matching Cipher, MAC, or Compression algorithm found. 
The SSH server does not support the algorithms you have selected in the session property. Try 
using a different algorithm. 
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The server rejected the session key. 
This may be due to a protocol error in the SSH client or server. You should contact the vendor of 
each program. 

The server sent a bad RSA challenge. 
This may be due to a protocol error in the SSH client or server. You should contact the vendor of 
each program. 

The server sent a disconnect packet. Reason of the problem. (Code: XXX) 
This may be caused by many reasons. There may be too many connections to the SSH server, or 
you entered an illegal user name. The exact reason follows after the message. 

The server rejected a request for user authentication service. 
The SSH server does not support user authentication. Check if the SSH server configuration on the 
remote server is set correctly. 

Failed to create a folder: ‘folder’ 
You may not have the permission to create a file in the folder, or the disk space may not be 
enough. 

Failed to create a shortcut. 
You may not have the permission to create a shortcut in the folder, or the disk space may not be 
enough. 

Failed to initialize OLE. 
Your MS Windows system does not work normally. 

Failed to open clipboard. 
Your MS Windows system does not work normally. 

Failed to delete clipboard. 
Your MS Windows system does not work normally. 

Failed to set the data on clipboard. 
Your MS Windows system does not work normally. 

Failed to authenticate FTP user. Would you like to retry again?  
The remote computer rejected you to login after the user authentication. Confirm your username 
and password. 

'xxx' session already exists. Try another session name. 
This error occurs when the session name for a new session already exists. Use a different session 
name. 

Could not transfer the requested file. The file is already ready or being transferred. 
This error occurs when you request a file transfer, but the file is already in “ready” state or “being 
transferred” state. Try again after canceling the ongoing file transfer. 
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Could not change the file 'filename'. The file already exists. Try another file name. 
A file with same name exists on the remote computer. Use a different name. 

Could not save the session. 
You may not have the permission to create a file in the folder, or the disk space may not be 
enough. 

Could not rename the file 'filename'. The FTP server rejected. 
You may not have the “write” permission on the remote host. Refer to the log message for more 
details. 

Could not create the folder 'foldername'. The FTP server rejected. 
You may not have the “write” permission on the remote host. Refer to the log message for more 
details. 

Could not create the log file. 
You may not have the permission to create a file in the folder, or the disk space may not be 
enough. 

Could not display the local folder. 
You may not have the permission to view the folder on your local Windows system. 

Could not display the remote folder. 
You may not have the “read” permission on the remote host. Refer to the log message for more 
details. 
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